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Definitions

Q:Shortcut Q:Advice G:Caution

Storage Capacity— Formerly called quota, in computer terms  E{Ula]aF=13%
is a space allocation limit. The current storage capacities for the

Towson University servers are:
E-mail Definitions
Storage Capacity Manage-
Faculty and Staff: 100 MB Students: 50 MB ment
1. Displaying Folders
Home Directory (H:\drive) on TU Server 2. Storage Capacity Status
Faculty and Staff: 1000 MB Students: 100 MB 3. Trouble Spots
(includes Web space) 4. Managing the Inbox Folder
5. Managing the Sent Items
Departmental Shares (O:\ drive) on TU Server Folder
Department specific, check with supervisor. 6. Emptying the
Deleted Items Folder
Turning Off the Journal
Web Pages .
. Managing Network Space
Faculty and Staff: 200 MB WWWNew: 500 MB 9. Archiving

Mailbox— A mailbox is where sent and received e-mails , personal folders, calendar items, and task
requests are stored. The storage capacity limit assigned to each account is 100 MB. A warning
message will be sent when the capacity reaches 90 MB. When the capacity reaches 95 MB the
account will not be able to send messages. When an account exceeds its storage capacity it will be
unable to send or receive messages until the account owner can reclaim used space.

Personal Folders—At Towson University, personal folders (.pst files) are stored on the user’s
H:\ drive and are backed up by OTS twice a day. The Storage capacity for the H:\ drive is 1000 MB.
Personal Folders can not be accessed Outlook Web Access.

Public Folders—These are also stored on the e-mail server, but no password is required. Everyone
within a specific group has access to e-mail messages in a Public Folder.

Figure 1

Storage Capacity Management #l il Foders E
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The ‘Folder List’ is an alphabetical listings of folders grouped L2 Drafts [2] .
together by type and located in the Navigation Pane. 'L-jf:'bife”"eﬂ” |
;‘!

To view the Folder List, hold the Ctrl key down and press the number 1
6 (Ctrl+6) or Select the Folder List icon from the bottom of the o~ _f
(=

Navigation Pane (Figure 1, 1). s
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If you do not see the Folder List icon choose the Configure buttons option

(Figure 2, 1). Otherwise go to Figure 3.
After choosing the Configure buttons option (Figure 2, 1)
1. Select Add or Remove Buttons

2. Select the Folder List button to add to the Navigation
Pane

Figure 2 Ell
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Looking Up Your Current Storage Capacity Status Figure 3
[+ L Zearch Folders —
After you have displayed the Folder List, you will see a link for Folder Ma.lsmx-T;hnology Training —

Sizes (Figure 3, 1).

Select the Folder Sizes link to open the Folder Size dialog window

£ Public Folders

9 Teresa Personal L |
Folder Sizes [
DafFFiE™Management. ., 1

(Figure 4). Use the scroll bar to display your folders and look for those -
that have a large size (Figure 4, 1). —

......... £
The Folder Size dialog window helps you identify which folders should be =1 ERE N e R
looked at to reclaim space. il s —
The Total size (including subfolders) will give you the total size of your
mailbox in kilobytes (KB) (Figure 4, 2).

Figure 4

Folder Size
Server Data |

When you display your folder size in Outlook, the sizes | Falder Mame: Mailbos - Pucciarella, Teresa®

are given in kilobytes (KB). However, the storage
capacity is given in megabytes (MB). To determine
your mailbox size in megabytes, divide the total size
given in Outlook by 1000.

In this example the total folder size, 2629 KB / 1000 <m ke
is equal to 2.6 MB. 2L KB

Size {without subfolders): \ OKB
Total size {including subfolders: f 2629 KB

Subfolder | / \ Total Size: | & |
Calendar 1t 165 KB
Contacts 4 KE
y 2
Kl

Deleted Trems OKE =
Crafts 1 4] KB

ISTC767 SKB SKB
Journal OKBE OKB
Jurk E-mail OKE oke x|

Close |

Storage Capacity Trouble Spots

+ Inbox— Every message, appointment and task request arrives here first.

+ Sent Items Folder — A copy of every item you send is copied here automatically.

+ Deleted Items Folder — Every message you delete

is moved here automatically

+ Journal Folder — The journal automatically creates an entry for every Microsoft document you
open to work on that is attached to an Outlook contact.
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Manading the Inbox

Each column heading in the list of messages is a sort button. By clicking on each of these buttons,
you will notice the messages sorting alpha-numerically according to that particular category.

To sort in reverse order, just click the heading a second time. Once you have the messages sorted,
you can easily mark items for deletion or move them to another folder. For more information please
see the OTS Quick Sheet:

http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/0Outlook_2003_0Organizing_Messages.pdf

If you are a Faculty member and communicate with you students using e-mail you should read:

http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/0Outlook_2003_sorting_student_email.pdf

If you have unwanted messages in your Inbox, hold down the Ctrl key and use the mouse to Select
the messages for deletion. Once the unwanted messages are highlighted, you can drag them to the
'‘Deleted Items’ folder or you can press the delete key.

Managing the Sent Items Folder

A copy of every item you send which includes mail, appointment and task requests are copied here
automatically. It’s easy to see how this folder can grow to a large size. You can manage this folder
by using the column headings to sort items and then move unwanted items to the 'Deleted Items’
folder.

Emptying Deleted Items Folder

To delete all items in the Deleted Items Folder at once, Right Click on the Deleted Items folder on
the Outlook Bar and select Empty ‘Deleted Items’ Folder.

Figure 5

To automatically empty this folder when exiting
Outlook, click on Tools, Options and then click the
Other tab and check to ‘Empty the Deleted Items
folder upon exiting’ (Figure 5).

Preferences I IMail Setup I IMail Format I Speling I Security  Other |Delegates I

r Empty the Deleted Items Folder upon exiting:

il

it -mail, Contacts, and
Calendar.

Turning Off the Journal

When activated, the Journal automatically records actions that you choose relating to the contacts
that you choose and places the actions in a timeline view. In addition to tracking Microsoft Outlook
items, such as e-mail, or other Microsoft Office documents, such as Microsoft Word and Excel, you
can keep a record of any interaction you want to remember. This sounds like a great deal but this
option will use additional space against your 40 MB mailbox allotment.

The Journal folder is off by default. If it has been turned on and you wish to turn it off go to the
Tools menu, select Options, then click on the Journal Options button. Deselect the checkmarks
next to options you want to turn off.

A better way to track all Outlook items is to use the Activities tab on the contact item in your
local contacts folder. You will be able to see each item sent and received and its location.
Please see the OTS Quick Sheet:

http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/0Outlook_2003_Locating_Correspondence.pdf



http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/Outlook_2003_Organizing_Messages.pdf
http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/Outlook_2003_sorting_student_email.pdf
http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/Outlook_2003_Locating_Correspondence.pdf
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Managing Your Network Space Figure 6

Teresa Perzonal.pst. .. Properties

Home Directory (H:) Drive Storage Capacity General |

In addition to your mailbox folders, you also have network @ Bl & e
file storage space usually referred to as the “H: drive”.
. Type: Multiple Types
To see your current usage on your H: drive:
Location: Allin H:Y, /
1. Double-click on My Computer Size: 19,4 ME (20,412,395 bytes)

i o A Size on disk:  19.5 MB (20,549,456 bytes)
2. Double-click on the listing for your H: drive

Attributes In

3. Select all of the files and folders by going to the Edit I pidden i
menu and choose Select All [7 Archive

4. View the properties for the collection of files and folders
by going to the File menu and choose Properties

5. Note that the Location is on the H: drive (Figure 6, 1) [ ok | concel apply

6. The total usage is listed in the “Size on disk” field
(Figure 6, 2)

To learn how to manage your Home directory storage capacity on the TU network see the

OTS Quick Sheet:
http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Tuning%20Up%20PC/Managing_H_O_Drives.pdf

Another way to manage your Outlook mailbox size is to create a personal folder in your Home
directory (H:\) drive. This folder can help to alleviate storage capacity problems in your mailbox.
It's size is counted against your Home directory allotment of 1000 MB rather than the 100 MB
allotted to your Outlook mailbox.

To learn more about creating Personal folders see the OTS Quick Sheet:
http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/0utllok_Personal_Folder.pdf

If you already have Personal folders created in you Outlook mailbox and need to move them to your
Home directory (H:\) please see the OTS Quick Sheet:

http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/0utlook2003_CreatingAndRelocatingPSTFiles.pdf

Archiving Messages Figure 7
An archived folder is stored as a PST folder so you can easily
archive any of your already created personal folders to your € archive allFolders accarding ta their Autaérchive settings
Home directory (H:\) drive. % Archive this Folder and all subfolders:
=l E5F Maibng - Purciarsla, T eresa” -
1. Click on the File menu and select Archive. EEZﬁZﬂZ
Use the dialog box to set the archive settings. 3 3?::3'{;"“
(Notice that more than just mail messages can be o
archived) (Figure 7). j :glggg;
3. Click OK. B Joura =
Archive items older than: [Fr) =l
Warning: The Archived Messages file is a (.pst) file and I Include tems with "o
9 is located on the C:\ drive by default. i:cx:::hfizpst
This must be changed to your Home directory (H:\) drive
(Figure 7, 1). I ==



http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Tuning%20Up%20PC/Managing_H_O_Drives.pdf
http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/Outllok_Personal_Folder.pdf
http://wwwnew.towson.edu/adminfinance/OTS/training/documentation/Outlook%202003/Outlook2003_CreatingAndRelocatingPSTFiles.pdf
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Retrieving Archived Messages

Once you have archived information, you may need to reference the material at a later date. When
you open the archive file, your messages will maintain the same organizational structure as before.
For example, if you archive messages in a folder called Campus Announcements, then there will be a
folder under Archive called Campus Announcements with the related messages inside.

1. From the main Outlook Window, go to the File Menu, select Open, then Outlook Data File.

Browse to the location specified when you have preformed the archive and double-click on the

archive file. |
Figure 11

3. Display the Folder List using the View menu, then
expand the Archive folders by clicking on the + sign
(Figure 11,1), and select the desired folder from the
list displayed.

| Quarantine
=7 Sent Items
+ L Search Folders

+

4. Close the Folder List when finished. F %chmhw Training

—~ B 62 (¥ k] Ca *

|I:I Ikems

Compacting Folders

Another strategy for reducing the size of your folder is to compact them.

1. Display the Folder List using the toolbar.

Figure 12
2. Right click on either Outlook Today or
Personal Folders.
General |H0me Page I
3. Select Properties from the bottom of the menu to
display the Properties display window . ﬁ JPersonal Folders
4. Click on the ADVANCED button (Figure 12, 1) Twpe: Folder containing Mail and Post Ikems
. . Location:  Mi ft Office Cutlook.
5. Click on the Compress Now button (Figure 13, 1). D°°a '_°:_ Icrasatt SHIES St
Description:
6. To exit, click OK, then OK again.
7. Close the Folder List.
Flgure 13 @ Shaw number of unread items
& e sl 6 s
General |
when posting ko this Folder, use: IIPM.Post
Mame: ersonal Folders N
Filename: I Hr\Persanal Folders pat v automatically generate Microsoft Exchange views

Encryption: | Compressible Encryption Folder Size |

Format: I Personal Folders &
| oK Cancel ApEy
Change Password. .. | S_han }et:.l;lrs used ko access

Reduces the size of your personal
Falder fil=

Compact Maw

Comrnent

Ok I Cancel Ll
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Using AutoArchive

You can choose to have Outlook Automatically archive

information on a regular basis. This is a two-step

process.
1. Click on the Tools menu and select Options.
2. Click on the Other tab and select the
AUTOARCHIVE button (Figure 8, 1).
3. Click in the first checkbox
‘Run AutoArchive every’ (Figure 9, 1) and
change any settings to suit your preferences.
4. Click on OK until you've returned to the main

window.

You may apply this setting to all of your folders by

selecting the ‘Apply these setting to all folders now’
button (Figure 9, 2).

Figure 8
[2]X]

Preferencesl Mail Setupl Mail Furmatl Spelling | Security  Other IDEIegates |

Options

General \‘

23]

m Empty the Deleted Tkems folder upon exiting:

v Make Outlook the default program For E-mail, Contac
Calendar,

N
Mavigation Pane Options.., | Advanced Q)

Autodrchive

Eo Manages mailbox size by deleting old items or moving them to
% atchive file and by deleting expired items,

Aukodrchive, .. |
Reading Pane
| ‘ % Customize options For the Reading Pane.
Figure 9
Autoiirchive

¥ Run Autoarchive every |14 ﬁdays

r ENV runs
During Autadrchivi
V¥ Delete expire il Falders only)

¥ Archive or delets oW items
v show archive folder in Folder list
Default Falder settings For archiving

Clean out items older than |6 ﬁ /

€ Move old items to:

H:harchive. pst

 Permanently delete old s

Apply these settings bo all Folders now |

To specify different archive settings for any folder, right-click.
on the Falder and choose Properties, then ga ko the
Autodrchive tab,

Set the AutoArchive Properties For Each Folder

Now that AutoArchive has been turned on, Outlook needs you to tell it how you want
to archive each folder.

1.
2.

5.
6.

Display the Folder List using the Toolbar.

Right click on the desired folder and select

Properties.

Click on the AutoArchive tab (Figure 10, 1).

Choose either:

e Archive items in this folder using the
default settings (Figure 10, 2).

The default settings are those chosen in
“Using AutoArchive” above.

e Archive this folder using these
settings (Figure 10, 2).
+ Set the time interval to your preference
(Figure 10, 3).

+ Items will be moved by default to the
default archive folder defined during the
AutoArchive configuration.

+ Click Move old items to (Figure 10,4).
This should be filled in with the choice
from “Using AutoArchive”

+ oOr you can choose to permanently
delete old items (Figure 10, 5).

Click on OK.
Close the Folder List.

Figure 10
E

) | Synchronization |
Autodrchive

Mancy Properties

Administration I Forms I
General I

€~ Do not archive ikems in this Folder

€ archive ikems in this Folder using the default settings

e

WEfaul A Ehi e S ELLTT 5 |

% Archive this Folder Using these settings:

Clean out items older than |3 ;| |Months .I

& Move old items to default archlve Folde

i Move old items to:
H: I|,arch|\n'|a pst

" Permanently delete old items

S

Retention policy

by

e

The network aamnistrakor has not set retention

palicies,

Hetentian Folic Iferation . |

o]

Cancel Apply |




